HPS Service Pack 14 FL ASH/Readme

ThisisIBM pSeries High Performance Switch (HPS) Service Pack 14 - Addendum 1.
This Addendum is issued to update the HMC , GFW, LL and PPE components.

This Service Pack details updates to these components:
Hardware Management Console (HMC) 3.3.6 - Build level 20050706.1

Globa Firmware (GFW) 3H050607 / 3J050405

Power Subsystem Microcode (PT Code) 26A8
HPS/SNI L P Software (CSS) 1.1.3.2

AIX 5L Version 5.2 bos.mp64 5.2.0.61

AIX LPs (HPC) aslisted in "Detailed L P L evel Check"
vSD

LAPI

HPS

PPE

L oadL
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This Service Pack Levels are:
SwitchNetwork Manager (SNM) 1.3.4.0 - Build Date: Wed 20 Apr 2005 05:49:22 AM EDT

Power Subsystem Microcode (PT Code) 26A8

HPS/SNI LP Software (CSS) 1.1.3.2

AIX 5L Version 5.2 bos.mp64 5.2.0.61

AIX LPs (HPC) aslisted in "Detailed LP L evel Check"

This Service Pack also contains general guidelines for upgrading the components listed in Section 3: "
Component update/download information”.

These guidelines are intended to be a supplement to the other IBM documents referred to in this
document. We strongly advise that you have the referenced documents available before you begin the
upgrade process. A list of referenced documents can be found in Section 1:Supporting Documentation.

The Code Levelslisted in Section 3: " Component update/download information” reflect the levels

available at the time of this Service Pack release.
Some components support only a single version, notably the Microcode for GFW and the Power




Subsystem. Subsequent released versions are expected to be backward compatible.

The procedure outlined in Section 4: "Recommended Installation Sequence (Overview)" isthe standard
sequence of installation.

Non-standard sequences and/or undocumented code levels may cause unforseen problems. In this event
please contact your Customer Service Representative.

If you are upgrading to this Service Pack from a service pack that isearlier than SP9, then installing
CSM1l.4isrequired.

Therecommended Al X servicelevel iSAIX 5L version 5.2isMLG6.

The Maintenance package contains CSM 1.4 which requires RPM update openCIM OM 0.8(5.2).

Because '/var' is a system data repository, system administrators should check periodically to maintain /var
such that thereis at least 30 Mb free [use 'df -K']. If it is more than 75% full, look for the directories that
contain the most data. [use 'du /var | sort -n' ]
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11. Genera Pardlel File System (GPFS) Library

12. Cluster System Management (CSM) Library

13. IBM Parallel Environment for AIX 5L Installation Version 4 Release 1.1

14. IBM LoadLeveler for AIX 5L and Linux Using and Administering Version 3 Release?
15. LoadL eveler 3.2 documentation updates

New SNM/FNM Features

MPI and LAPI Performance Enhancements

Support for Node Switch Board (NSB) and Intermediate Switch Board (1SB) failure
Application striping and fail-over of packets across multiple interfaces for fault resilience
Application Checkpoint/Restart and preemption

The Web-based System Manager Remote Client ak.aWebSM PC CLIENT may need to be
reinstalled

RDMA (remote direct-memory access ) transport on HPS
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1. New SNM Features:

New features and functions (on The Switch Network M anagement Panel ):
Introduced in HMC 1.3.1.0 - Service Pack 9

For details of operation please see Chapter 4. System management components and Appendix E. Switch
Network Manager (SNM) in
pSeries High Performance Switch (HPS) Planning, Installation and Service Guide (GA22-7951-02) (HPS

Guide)

Features:

HMC Fail-over: FNM/SNM daemon ("Enable SNM Software in Normal Mode") runs on up to four
HMCsin the cluster.

Verification mode: "Enable SNM Software for Switch Network Verification" used to check out the
system.

Functions:

There are three(3) new tasks and one(1) renamed task on the Switch Network Management Panel :
NEW: "Select Logical Topology", "Display Cluster Components’, "Enable SNM Software for Switch
Network Verification" RENAMED: "Enable SNM Software for Norma Mode" used to be "Enable SNM
Software"

. *** Select Logical Topology thisintroduces arequirement to set the logical topology of your



http://publib.boulder.ibm.com/clresctr/windows/public/gpfsbooks.html#all_clusters23
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system before enabling SNM software. If the logical topology has not been set, neither of the tasks
to Enable SNM Software will be selectable. Thisis required. See note 1.
o Note: If you are using the SNM Fail-over support introduced in the Software Update
release, the logical topology must be set on each HM C where you enable SNM software.

. Display Cluster Components shows the frames and cages of the cluster components with which
SNM can communicate. This task can only be used if SNM software isNOT enabled.
o The new Isswcomp command provides the same function as the "Display Cluster
Components' task.

. Enable SNM Software for Switch Network Verification task is used to check out the system by
NOT removing bad links or routes. The main purpose is to discover cable mis-wires and defective
hardware. No Routing is modified or loaded. It is NOT intended to be used in aworking
environment.

. *** Enable SNM Software for Normal Mode. select thisto run SNM in anormal, working
environment. Thisisrequired. See note 1.

Notes:
1) *** If you are upgrading from Service Pack 8 or less, then these steps are REQUIRED for an
initial installation of FNM/SNM:
First Select Logical Topology then
Enable SNM Software for Normal Mode.
See "Enable SNM Software" in the HPS Guide.

2) The systems topology selected needs the number of NSB' and | SB's calculated on a per plane basis.

Ex: For a configuration with two NSB's and two planes, there is one NSB per plane with 16 endpoints per
plane.

This equatesto: 1 Network, 2 Planes, INSB_OISB_16EP.




2. MPI and L API Perfor manceEnhancements:

LAPI and MPI host communication stacks have been tuned, based on experience, for lower latency. These
changes complement the communication performance improvements released in part 1. They are being
released as one package with the LAPI and MPI striping function.

Note: Beginning with the Service Pack 9:

- asingle MPI user-space job which wants to use HPS adapters in both of two switch planes must set
MP_EUIDEVICE=sn_all(or csss). In previous releases, a single MPl/us job with multiple tasks per node
could use adapters from two planes by setting MP_EUIDEVICE=sn_single (or css0).

- A job which sets MP_EUIDEVICE=sn_single will only be able to use half of the HPS adapters on the
nodes where it runs.

- A job must set MP_EUIDEVICE=sn _all in order to use al the HPS adapters in the nodes it is using.

3. Support for Node Switch Board (NSB) and Inter mediate Switch Board (NSB) failure:

The SNM daemon has been enhanced to ensure that the failure of an NSB and an 1SB will be handled
appropriately. The main enhancement is that the Switch Network Manager daemon gathers and downloads
multiple path table updates into a single transaction instead of one update per transaction. An entire switch
board failure or recovery will generate multiple of path entries changes. Therefore handling these updates
in groups involves many fewer transactions. These can be processed in a more timely fashion and place a
smaller load on SNM and the service network.

4. Application striping and fail-over of packets across multiple interfacesfor fault reslience:
Striping provides a method for asingle task of a parallel application to utilize multiple SNI links. This
allows asinglelink to fail without the application using the link being terminated because thereis an
alternate path to all other tasks of the application. The striping method implemented is designed to provide
resilience to switch or interface/link failure and is not designed to provide an increase in the aggregate
network bandwidth as seen by tasks.

Thislink failure resilience function requires support in LoadLeveler, Paralel Environment and the host
communication stack for MPI and LAPI. When an interface/link recovers, the striping function will ensure
that the link is used again. Another goal of this striping design isto evenly distribute traffic over multiple
switch networks to maintain a balance in the communications load.

KNOWN ISSUES/CONCERNS

- In non-striping mode you only get half the links on a p655 system using a 2 plane configuration when
setting MP_EUIDEVICE=sn_single. You must use MP_EUDEVICE= csssor sn_all to get al links.

- Performance degradation for single task per link of 3% for unidirectional and 5% for exchange
bandwidth at large messages. However, multiple tasks per link get full link bandwidth.

- Striping currently limited to two links per task. Multiple tasks can use dl links aslong as there are more
tasks than half the links available.

Note that when using RDMA, thereisno lar ge message performance penalty for striping. In fact




striping greatly improves large message RDM A bandwidth. The above performance degradation
occursonly in packet mode.

5. Checkpoint/Restart and Preemption:

Checkpoint/restart provides a way to stop and resume applications at some later time. It isavery useful
tool in managing the clusters workload since applications can be check-pointed to allow other applications
to run or the system made inactive for a maintenance window.

Preemption is also provided so arunning application can be suspended to allow another higher priority
application to execute right away.

6. The Web-based System M anager Remote Client ak.aWebSM PC CLIENT

If the Web SM is updated, it is recommended that the existing code be reinstalled on your remote server or
PC to ensure that the WebSM
is compatible with this HMC Build.

Toinstall the PC Client software on your remote server or PC go to: http://<hmc-hostname>/remote_client.
html .

The two versions you see there are the "legacy" websm client - "install shield" and "The future of websm
clients." - webstart. Both versions can exist ssimultaneously on your client workstation

Install shield:

If thereisacurrently installed install shield version of WebSM, it must be UNinstalled before the new
version isinstalled.

Uninstall : From Start -> Control Panel -> Add/Remove Programs -> Web-based System Manager Remote
Client click "Change/Remove" and follow instructuions.

Failureto uninstall will result in undefined behavior of the WebSM PC Client.

Install : Go to: http://<hmc-hostname>/remote_client.html -> "Install Shield" -> select the Operating
System where the program will be running.

Select "Open" to immediately install on the machine on which the browser is running.

Selecting "Save" will allow you to store the install program for installation at alater time.

NOTE: Thisisa 100 Mb file so either process will require about 15 minutes.

Once saved it isa self extracting file that can be used to upgrade multiple PC's.

Webstart:

The webstart installation is atwo part installation

first - install the 1.4.2 JVM that is has the webstart code.

second - invokes the launch code and gets the initial classes downloaded from the HMC.




A feature of the webstart client is that when the client is launched, it will check for new jar files on the
HMC and download them, so subsequent update of the HM C server code do not require the webstart
client code to be constantly updated .

There may be an issue of having multiple jvms on the client workstation and the default jvm path not
pointing to the IBM 1.4.2 jvm. Webstart does not work well with the sun 1.4.2 jvm, so some cleanup of
multiple jvms on your workstation may be needed.

The Java Web Start version requires multiple logins on launching. Y ou have to login to the original HMC
whenever you try to connect even if you're just downloading the webstart .jsp files.

If you are getting the .jsp filesfrom aregular AIX box, you will have one less login.

Y ou dont experience thisin the non-webstart websm because you are not connecting to the webserver to
download the .jsp files. Trying to 'cancel out' will result in multiple (up to 16) re-presentations of the login
verification box.

1) Install Java Web Start:

JavaWeb Start for Linux Install Java Web Start on aLinux platform. Once installed, return to this page to
download the Remote Client. Java Web Start for Windows Install Java Web Start on a Windows platform.
Onceinstalled, return to this page to download the Remote Client.

2) Download Web-based System Manager Remote Client for Java Web Start:

Remote Client Download Web-based System Manager Remote Client for Java Web Start on Linux and
Windows systems.

The images are quite large, so it may take some time for the download to complete.

/. RDMA transport on HPS

Summary:

The IBM eServer pSeries High Performance Switch (HPS) with Remote Direct Memory Access (RDMA)
enabled delivers 1.8GB/s of unidirectional bandwidth across asingle link and over 3.5GB/s over 2 linksto
asingle MPI task for some applications. Bidirectional bandwidth measures almost 3.0GB/s over asingle
link and over 5.9GB/s for asingle MPI task striping over 2 links.

These measurements were achieved on 2 nodes containing 1.9GHz, Power 4+ based processors with 32
CPUs and 2 HPS adapters, and links on each of the 2 nodes. Large

pages and cache-line aligned buffers were used for the MPI measurements. These results indicate nearly
linear scaling of large message striping performance. A singlelink is able

to deliver over 1.65GB/s of bandwidth over TCP/IP.




Advantages of RDMA transport:

. Decouples the CPU from the movement of data allowing for better overlap of computation and
communication.

. Reduces the computational load of the CPU by off-loading segmentation and reassembly of
messages to the network adapter, thereby reducing the number of packet arrival interrupts.

 Reduces the stress on the memory subsystems by reducing the number of bus crossings - one I/O
bus crossing versus the traditional 2 memory bus and 1 1/O bus crossing when not using RDMA.

. Enablesthe protocolsto efficiently stripe a message (or different messages) from a single task
across multiple network interfaces to exploit the available communication bandwidth in parallel
without engaging multiple CPUs.

. Providesimproved raw transport performance. In cases where the transport bottleneck is the copy
rate (memory bandwidth), RDMA helps eliminate that bottleneck.

How can applications better exploit RDMA?

To exploit the overlap potential of RDMA, applications should make use of non-blocking calls and
schedule communication as early as possible to extract the full overlap potential.

For MPI/LAPI applications the RDMA transport kicks in for large messages (to justify the setup costs of
RDMA).

Applications that reuse the same communication buffers will benefit further from RDMA since the setup
cost isamortized over larger number of transfers.

For applications that send large messages asynchronously, enabling striping should help the applications
realize superior transport bandwidth.

RDMA transport is disabled by default in this code release in order to insure that customers running
production workloads that do not need RDMA operate without change.

Note : When RDMA is enabled by changing the device attribute rdma_xlat_limit to avalue greater than
0, itispossible for an RDMA enabled job to surpass the AI1X pin limit which may lead to a hung system.
If thispin limit is exceeded slowly enough the parallel application will catch a SIGDANGER signal and
kill the job. However, if this pin limit is exceeded too rapidly, A1 X may resort to killing processes,
including systems processes, which may cause system to appear to be hung. This situation may be
prevented by setting the rdma_xlat_limit to a number which is smaller than 4096 times the sum of the
number of large and small pages on the system.

RDMA Usage:

By default, the RDMA capability of the SNI adaptersis turned off.

Use the chdev (or optionally /usr/sni/aix52/chgsni) command to turn on RDMA by setting rdma_xlat_limit
to avalue greater than 0xO.

The rdma xlat_limit attribute controls amount of memory alowed for RDMA, per LPAR.

The default value of the rdma_xlat_limit attribute is 0x0, effectively turning RDMA off.




When using RDMA it is recommended that this attribute value be set to value equal to 75% of small page
memory.

Thiswill allow all of the large pages on the system and most of the small pages to be mapped to the sni
adapters.

PLEASE NOTE: Thisodm attr (rdma_xlat_limit ) ischanged for ALL sni'sin an LPAR with just
the single command.

For the changeto take effect, the LPAR must be rebooted.

The RDMA option MUST beturned ON OR OFF acrossthe entire cluster.

If it isnot, SNI adapterswill not communicate dueto version mismatch failures!

NOTES:

When RDMA s turned on, the IP protocol automatically usesthe RDMA capability.

For user space jobs, an additional LoadL eveler keyword (bulkxfer=yes) must be set in the

LoadL eveler job control file to indicate that thisjob is requesting RDMA.

This allows users to run both RDMA and non-RDMA jobs on the system.

For the most current details see: L oadl eveler 3.2 documentation updates; Addition of support for Bulk
Data Transfer ...

For more information, please see the "LoadlL eveler Using and Administration Guide".

To enable RDMA:/usr/shin/chdev -I sniX -ardma xlat_limit=XLAT_LIMIT ; where XLAT LIMIT is
75% or less of the small page memory.

To disable RDMA:/usr/sbin/chdev -l sniX -ardma xlat_|imit=0x0000000000000000

To check the RDMA status: -- run Isattr -El sniO ; |sattr -El snil;

Ex: fori in "Isdev|grep sni.* Avail|awk ‘{ print $1} ; do Isattr -El $i|grep rdma; done

chdev Usage: chdev -1 Name [-a Attribute=Value]...[-p ParentName][-P|-T]

chdev -| Name -ardma xlat_limit=size

The 'True' seen in the |sattr output is whether or not the value is user modifiable.

Therdma xlat_limit attribute is one of 5 that are not valid on just 1 sni -- so the change method updates
the odm for al sni's

This attribute is modified for al existing devices. Any user supplied -l option isignored.

Attribute values for rdma xlat_limit :

Default value: 0x0 (Implies RDMA is turned off)

MINimum value: 0x0

MAXimum value: OXFFFFFFFFFFFFFFFF ( Maximum amount of memory allowed for RDMA (in
bytes). )

Recommended value: 75% or less of small page memory.

Regarding the use of memory by RDMA and TLP.

Real memory isdivided into 2 categories - Small Pages and Large pages.

It isthe users responsibility to achieve an optimal balance between the the 2 categories based on the
expected and/or experienced needs of

both SNI adapters memory requirements expressed in TLP and applications use of Small Pages as
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expressed in RDMA.
TLP can allocate up to 75% of real memory.
RDMA can pin and map up to 75% of small page application memory.

Total Real Memory is afunction of N(bytes of real mem) = T(bytes of real. mem allocatedto TLP) + S
(bytes of real mem alocated to Small Pages)

Small Page memory is afunction of S(bytes of real mem allocated to Small Pages) = N(bytes of real
mem) - T(bytes of real mem allocated to TLP)

Large Page memory is afunction of T(bytes of real mem allocated to TLP) = N(bytes of real mem) - S
(bytes of real mem alocated to Small Pages)

The amount of small page memory can be calculated as follows:
Isattr -E -I sysO -a realmem returns the number of kbytes real memory, call this number A.
vmo -0 Igpg_regions returns the number of large pages, call this number B.
Then A*1024 - B*16* 1024* 1024 is the amount of small page memory in bytes.
Ex:
#!/bin/ksh

real_mem="lsattr -E -l sys0 -arealmeml|awk ‘{ print $2} "
lgpg_regions="vmo -o Igpg_regionslawk ‘{ print $3} "
A=3(( real_mem * 1024))

B=%(( Igpg_regions * 16*1024*1024))

print "Real Mem=%A, TLP=$B; Small pages=%((A - B))"

Real Mem=32212254720, TLP=4294967296; Small pages=27917287424

The rdma_xlat_limit will limit the amount of memory that a user application can pin and map for use with
RDMA.

This pinning and mapping only survives as long asthe job it executing. After it exitsthe memory is
unpinned and freed.

See also Regarding the use of memory by TL P in Section 5: Installation Guidelines: step 3b.




IComponent
HMC

SNM/ENM

Service pack updates Download sites

The HMC code level for this Service Pack isHMC  HMC corrective service
V3R3.6

OR
Choose HMC Update V3R3.6 (APAR#1Y 72718

PTF# US03789 ) HMC p4 updates

This Service Pack updates this component.

Note: CD images cannot be downloaded directly
from this site.

Contact your IBM Sales Representative or Business
Partner, and order Hardware Feature Code (MES)
0960 for the initial upgrade CDs.

NOTE: If you plan to use the removeable media,
please read the Important Notice regarding the use of
the Format Removable Mediatask: HM C p4 updates

The SNM code leved for this Service Pack is SNM HMC corrective service
Version: 1.3.4.0-1

OR
Under SNM updates chose "SNM Srvice Pack

13" (APAR 1Y 70668 PTF U803491 ) SNM Service Pack
Apply V3CertisUpdate.zip first.

then apply

SNM_Serv_Pack13.zip (APAR 1Y 70668 PTF

U803491)

This Service Pack does not update this component.

The Firmware level for this Service Pack is Microcode download (Systems)

ROM Level (aterable).......3H050607 (P690)
ROM Level (aterable).......3J050405 (P655)

This code is machine specific. Go to the "System”

section.

For 7040-681 Version 3 p690 models, choose
"version 3H050607".

For 7039-651 p655 models, choose
"version 3J050405".

download the GFW img file:



http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://techsupport.services.ibm.com/server/hmc/power4
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/ptf_SNMServPack13.html
http://techsupport.services.ibm.com/server/mdownload/download.html

3H050607.img for p690
OR
3J050405.img for p655

This Service Pack updates this component.

Note that GFW isavailablein IBM CORE 3-4 days
earlier than the above mentioned website. Please
contact your IBM CE for the GFW in IBM CORE if
not available on website.

Refer to this website for detailed download and
unpacking procedures:
http://techsupport.services.ibm.com/server/

mdownl oad/downproc.html

Power Subsystem The Power Subsystem Microcode level for this Download microcode (Other)
Microcode Service Pack is 26a8.

Go to "Power Subsystem for 7039-651 (p655) and
servers containing the 7045-SW4 (High Performance
Switch)"

This Service Pack updates this component.

Code is the same for both p690 and p655:

ptcode-1.74.26a8-1.i386.rpm

Note that Power Subsystem Microcode is available
in IBM CORE upto 1 week earlier than the above
mentioned website. Please contact your IBM CE for
the Power Subsystem Microcode in IBM CORE if
not available on website.

AlX The AlIX level for this Service Pack is5.2.0.61 pSeries support fixes

Apply AIX52 ML-06 APAR 1Y67913
plus AIX5L Version 5.2 PTF - Specific Fixes
1Y 71994

This Service Pack updates this component.



http://techsupport.services.ibm.com/server/mdownload/downproc.html
http://techsupport.services.ibm.com/server/mdownload/downproc.html
http://techsupport.services.ibm.com/server/mdownload/other.html
http://www-1.ibm.com/servers/eserver/support/pseries/aixfixes.html

CSM openCIMOM
openCIMOM CSM 1.4 requires RPM update openCIMOM 0.8(5.2) update

If you are APPLY ING software for csm.server
1.4.1.1, please install the following images from the
AlX Installation MediaVolume 2:

tcl

tk

expect

conserver-8.1

AlX Licensed Program (L P):

The LPfileset fix levelslisted in the table below indicate the latest available levels at the time this HPS
Service Pack was rel eased.

As aconvenience, the table contains an "order the latest” APAR number for each of the LPs. If you click
on the LP Component link, you will be sent to the website 'pSeries support fixes where you can get the
latest available fixes for that component. The APAR package will contain fix levels that are the same or
higher than the levels listed below.

If you prefer, you can download the entire bundle of fixesfor ALL componentsin the table
by referencing APAR 1Y 72296.
To check the LP service levels, on each logical partition issue:

ISlpp -Lc | egrep "vsd|L APIHPS]|sni|ppe|L oadL [mmfsjrsctjcsm|essl |pesd™ | cut -d : -f 2,3 |sed 'S/:/ /'

Detailed LP Level Check

LP |Re|ease Component ID }APAR L evel check

Component

VSD 410 5765G2602 IY71747 rrsct.vsd.cmds 4.1.0.12
rsct.vsd.rvsd 4.1.0.10
rsct.vsd.vsdd 4.1.0.11
rsct.vsd.vsdrm 4.1.0.4

LAPI 233 5765G2601 IY71750 rsct.lapi.rte 2.3.3.2

rsct.lapi.nam 2.3.3.0
rsct.lapi.samp 2.3.3.0



http://www-1.ibm.com/servers/aix/products/aixos/linux/download.html
http://www-1.ibm.com/servers/aix/products/aixos/linux/download.html
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71747
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71750

HPS/SNI

PPE

PPE

GPES

GPES

GPES

113

411

420

320

330

210

221

230

5765G2400

5765F8300

5765F8300

5765E6900

5765E6900

5765F64AP

S5765F64AP

57/65F64AP

1Y 71758

Y71761

1Y 71763

Y 71764

1Y 71765

Y 71766

1Y 71767

'Y 71768

devices.chrp.IBM.HPS.hpsfu 1.1.3.0
devices.chrp.IBM.HPS.rte 1.1.3.2
devices.common.IBM.sni.ml 1.1.3.0
devices.common.|BM.sni.ntbl 1.1.3.1
devices.common.|IBM.sni.rte 1.1.3.2

ppe.perf 4.1.1.4
ppe.poe4.1.1.9
ppe.pvt4.1.1.1
ppe.dpcl 3.3.4.0
ppe.loc.license 4.1.0.0
ppe.man4.1.1.2

ppe.poe4.2.0.1
ppe.man 4.2.0.1
ppe.loc.license 4.2.0.0
ppe.dpcl 3.3.3.0
ppe.perf 4.2.0.0
ppe.pvt 4.2.0.0

LoadL .full 3.2.0.16
LoadlL.so 3.2.0.15

LoadL .loc.license 3.2.0.0
LoadL .tguides 3.2.0.1

LoadL.s0 3.3.0.1

LoadL .full 3.3.0.1

LoadL .loc.license 3.3.0.0
LoadL .tguides 3.3.0.0

mmfs.gpfs.rte 2.1.0.19
mmfs.base.cmds 3.5.0.11
mmfs.base.rte 3.5.0.17
mmfs.msg.en_US 3.5.0.8

mmfs.base.cmds 3.6.1.6
mmfs.base.rte 3.6.1.6
mmfs.gpfs.rte 2.2.1.6
mmfs.gpfsdocs.data 3.6.1.2

gpfs.base 2.3.0.2
gpfs.docs.data 2.3.0.2



http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71758
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71761
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71763
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71764
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71765
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71766
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71767
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71768

CsSMm 141 5765E88AP IY71770 csm.gui.websm 1.4.1.1
csm.client 1.4.1.2
csm.core 1.4.1.2
csm.dsh 1.4.1.2
csm.diagnostics 1.4.1.1
csm.server 1.4.1.2
csm.gui.dcem 1.4.1.2

pssp.pssp_to csm 1.1.1.0
Standard input: END

rpms:
conserver-8.1.7-2
expect-5.32-1
tcl-8.3.3-1
tk-8.3.3-1
openCIMOM-0.8-1

RSCT 236 5765F07AP IY71771 rsct.core.auditrm 2.3.6.1
rsct.basic.hacmp 2.3.6.1
rsct.basic.sp 2.3.6.0
rsct.basic.rte 2.3.6.2
rsct.exp.cimrm 2.3.6.1
rsct.compat.basic.hacmp 2.3.6.0
rsct.compat.basic.sp 2.3.6.0
rsct.compat.basic.rte 2.3.6.0
rsct.compat.clients.hacmp 2.3.6.0
rsct.compat.clients.sp 2.3.6.0
rsct.compat.clients.rte 2.3.6.0
rsct.core.errm 2.3.6.0
rsct.core.fsrm 2.3.6.0
rsct.core.gui 2.3.6.0
rsct.core.hostrm 2.3.6.0
rsct.lapi.nam 2.3.3.0
rsct.lapi.rte 2.3.3.2
rsct.lapi.samp 2.3.3.0
rsct.core.lprm 2.3.6.1
rsct.core.sr 2.3.6.0
rsct.core.rmc 2.3.6.2
rsct.core.sec 2.3.6.2
rsct.core.sensorrm 2.3.6.1
devices.chrp.base.ServiceRM 1.2.0.52
rsct.core.utils 2.3.6.2
rsct.vsd.rvsd 4.1.0.10
rsct.vsd.cmds 4.1.0.12
rsct.vsd.vsdd 4.1.0.11



http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71770
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY63036
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=IY71771

rsct.vsd.vsdrm 4.1.0.4

rsct.sdk 2.3.3.0
Parallel 310 5765F8400 PQ96735 pesdl.loc.license 3.1.0.0
ESSL PQ99640 pess.man.en_US3.1.0.0

pessl.rtemp 3.1.0.0
pessl.rte.up 3.1.0.0
pessl.rte.common 3.1.0.1
pessl.rtersl 3.1.0.1
pesdl.rters2 3.1.0.0
pessl.rte.smp 3.1.0.1

Parallel 320 5765F8400 pessl.loc.license 3.2.0.0

ESSL pessl.man.en US 3.2.0.0
pessl.rte.mp 3.2.0.0
pessl.rte.up 3.2.0.0
pessl.rte.common 3.2.0.0
pessl.rte.rsl 3.2.0.0
pessl.rte.rs2 3.2.0.0
pessl.rte.smp 3.2.0.0

ESSL 410 5765F8200 PQ90826 esd.loc.license4.1.0.0

PQ90823 ess.man.en_US4.1.0.0

essl.rtemp 4.1.0.0
essl.rte.up 4.1.0.0
essl.rte.common 4.1.0.1
essl.rtersl 4.1.0.1
essl.rters2 4.1.0.0
essl.rte.smp 4.1.0.1

ESSL 420 5765F8200 PK02186 esd.loc.license4.2.0.0
ess.man.en US4.2.0.0
essl.rtemp 4.2.0.0
essl.rte.up 4.2.0.0
esdl.rte.common 4.2.0.2
esdl.rtersl 4.2.0.2
esdl.rterrs2 4.2.0.0
esdl.rte.smp 4.2.0.2



http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=PQ96735
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=PQ99640
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=PQ90826
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=PQ90823
http://www-912.ibm.com/eserver/support/fixes/fcgui.jsp?whichFix=APAR&fixes=PK02186

Install HM C Software

Important Preliminary steps:

- Check if HMC isat HMC V3R3.0 or higher before you can install this update (required).
- Check if BIOS update is required on HMC.

- Check if BIOS hyperthreading is to be disabled on HMC

- Disable the SNM/FNM software from the Switch Network Management Panel.

Perform one of the following installation tasks:
- New Install HMC from Recovery CD OR

- Install Upgrade from Recovebry CD OR

- Update from .zip file (web)

Level Check: Verify that the HMC Code Level isthe current level shown in Section 3: Component
update/download information

Install SNM Software

Before installing SNM_Serv_Pack14.zip on any pSeries HMC, you must first install V 3CertsUpdate.
zZip.

This package updates the SNM HMC certificate information and resolves issues caused by expired
certificates. Failure to install this package will result in afailed Service Pack installation, and your
system will not be updated.

Install the file V3CertsUpdate.zip using the HMC Corrective Service GUI.

Level Check: Verify that the SNM Code Levdl isthe current level shown in Section 3: Component
update/downl oad information

Install HPS/SNI L P Software

IMPORTANT:

If you are upgrading from Service Pack 6 or below - do not reboot logical partitions (LPARS) until
after Step 4 Install GFW is compl ete!

See Problem #1 in the "Known Problems" section of this document for more information.

Level Check: Verify that the HPS Code Level isthe current level as shown in Section 3: Component

update/downl oad information




4 |Install GFW

Using the recommended AIX command line (update_flash) method with alocally available GFW
img file.

Level Check: Verify that the GFW Code Level isthe current level shown in Section 3: Component
update/download information

For detailed download and unpacking procedures:
http://techsupport.services.ibm.com/server/mdownl oad/downproc.html

5 |Install Power Subsystem Microcode on each frame

Level Check: Verify that the Power Code Level isthe current level shown in Section 3: Component
update/download information

6 |Instal AlX base updates plus any PTFs on each node

Level Check: See Section 3: Al X download info for the recommended Al X service level for this
Service Pack.

7 |Install AIX LP updates on each node

Note:

CSM LP's need to download and install openCIMOM-0.8-1 RPM update.

If you are APPLYING software for csm.server 1.4.1.1 Please install the following images from the
AlX Installation Media Volume 2:

tcl

tk

expect

conserver-8.1

Level Check: see"Detailed LP Level Check™

HMC Installation Guidelines:



http://techsupport.services.ibm.com/server/mdownload/downproc.html

1 |Instal HMC Software
Important Preliminary steps:
. Verify HMC Codelevel - at V3R3.0 or higher before installing this update (required).
. Check if BIOS update is required on HMC.
. Check if BIOS hyperthreading is to be disabled on HMC
. Disable the SNM/FNM software from the Switch Network Management Panel.
. Customer Decision regarding install, upgrade or update.
Perform one of the following installation tasks:
. New Install HMC from Recovery CD OR
. Install Upgrade from Recovery CD OR
. Update from .zip file (web)
The HMC installed with this Service Pack has an updated HMC WebSM PC CLIENT.
Toreinstal thisversion:
Uninstall - reinstall HMC WebSM PC CLIENT (Install Shield version)
Level Check: Release 3, Version 3.6HMC Build level 20050706.1
Important Preliminary steps:
la |Veify HMC Code level
Installation of HM C Recovery CD requires an upgrade install if you are installing an existing
HMC whose version isR3 V2.6 or less.
Please read HM C corrective service for important information regarding HMC Recovery CD's.
Contact your IBM Sales Representative or Business Partner to order HMC Machine Specific CDs
1b |Check if BIOSupdateisrequired on HMC.

There is amandatory Bios upgrade required for these HMC PC's:

7315-C03, 7310-C03, 7315-CR2, 7310-CR2

If your HMC model is not alisted, skip this step.

If you are updating the HMC on alisted model, then you must first update the BIOS of that HMC
model. The BIOS and install instructions can be obtained by linking to the "BIOS Updates' for the
referenced machine from the HM C Power4servers Page.

This BIOS will also ship as part of Feature Code 0960.



http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/ptf_v3r35Recover.html
http://techsupport.services.ibm.com/server/hmc/power4

1c

Check if BIOS hyperthreadingisto be disabled on HM C.

Many of the rack mounted HMC's (8187-KUH, 7315-C03) have a BIOS option to enable
hyperthreads.

The imbedded kernel will not run well when this option is enabled.

Y ou must disable this setting before upgrading to HMC3.3.5

1d

Customer Decision regardinginstall, upgrade or update.

Beginning with HMC Version 3 Release 3.2, (Service Pack 10) the Ext3 (JFS) filesystem will be
enabled if customers perform a New Install/ Upgrade to this new level of code by using the HMC
Recovery CDs. The Ext3 filesystem is ajournaled filesystem and is more reliable and less prone to
corruption in case of unexpected loss of power on the HMC.

Please note the differ ence between Upgrade and Update:

. Upgradeisdoneviacd load as described in - Perform an Install New / Upgrade
. Updateisdone viadownloading a zip file as described in step - Perform an Update

NOTES:

. Updatingto HMC Version 3 Release 3.3 or later using the Install Corrective Service will
not enable this feature.
. For Upgrade Installation

The following steps must be taken, prior to rebooting the HMC for the Upgrade process.

= Ensure that the user's home directories are not filled up with debug data.
( The Upgrade partition only has 2GB in free space to preserve the upgrade
data.) -

= Ensure that HMC debug is turned off. This can be achieved by running the
command pedbg -d off. ( With debug enabled, certain log files will be locked
for writing and will prevent the Save Upgrade Data task to complete
successfully. )

. Perform a Save Upgrade Data task from the Software Maintenance Panel on
the HMC console. The Perform a Save Upgrade Data task should be run
immediately before doing the reboot of the HM C with volume 1 of the
recovery CD. If the HMC reboot does not go to the install menu of volume 1
of the recovery CD, you should repeat the save upgrade task.

. The procedure for both Installation and Upgrade is identical except:
o For New Installation: When asked to perform an Install/Recovery or Upgrade, select
Install/RecoveryF8.




o For Upgrade Installation: When asked to perform an Install/Recovery or Upgrade,
select Upgrade F1.

I nstallation steps:

le

Disable the SNM/FNM softwar e from the Switch Network Management Panel.

Disable SNM Software:

Selecting the "Disable SNM Software” task option opens atask dialog box that stops the SNM
daemon for both verification mode and norma mode.

See: Appendix E. Switch Network Manager (SNM) in pSeries High Performance Switch Planning,

Installation, and Service

Do thison al HMC's attached to the cluster.

1f

Perform a New Install / Upgrade:
Install HM C Recovery CD 1 on all HM Csin the system - Required
Install HM C Recovery CD 2 on all HM Csin the system - Required

- Reboot the HM C with volume 1 of the recovery CD inserted in the DVD Ram drive.

NOTE: If the HMC failsto boot volume 1 of the recovery CD, the boot sequence in the HMC
B1OS may need to be changed so that the DVD/CDROM is before the hard disk in the startup
seguence.

If you have run the save upgrade data task before the startup sequence was set correctly, then you
should rerun the save upgrade data task before installing the HMC with volume 1 of the recovery
CD.

- Select F8 for New Installation

OR

- Select F1 for an Upgrade installation. (NOTE: ThisisNOT the same asan UPDATE)
- On the next screen to confirm your selection. Select F1.

- The Install/Upgrade process will proceed until -

- At some point you will be prompted to insert the second CD.

- Remove the CD from the DVD Ram drive and hit enter when the install is completed.



http://publib.boulder.ibm.com/epubs/pdf/aq1h3mst.pdf
http://publib.boulder.ibm.com/epubs/pdf/aq1h3mst.pdf

1g

Perform an Update

If you are UPDATING from Service Pack 7 (HMC V3 R3.0) or higher and chooseto do the
UPDATE:

Install HMC PTF HMC_Update V3R3.6.zip

Install from the HMC support link ONLY if the HMC isat a Release 3 Version 3.X level (3.3.X):
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html

- Select HMC PTF Update for Service Pack 14

- Usethe HMC --> Install Corrective Service option to install.

- Reboot HMC after successful installation.

You may install thisUPDATE directly from the web: via" HMC Install Corrective Service"
see step 3 Install Update, in HM C Readme -
http://techsupport.services.ibm.com/ser ver /hmc/power 4/fixessmcode/ptf v3r36mce.html

1h

Web-based System Manager Remote Client ak.aWebSM PC CLIENT

After the HMC Install New / Upgrade or Update is complete, the Install Shield version of the
Web-based System Manager Remote Client a.k.aWebSM PC CLIENT may need to bereinstalled
on your remote server or PC.

Follow these ssimple instructions:

uninstall, if present, existing Websm client via Control Panel "Add/Remove Programs' by
selecting "Web-Based System Manager Remote Client" and clicking on ‘Change/Remove’.

To Install: Using your preferred web browser visit the just recently installed HMC at this URL :
http://<hmc-hostname>/remote_client.html

(down load and install may take 10 to 20 minutes.)

For pertinent information see :

Section 2: Software Updates/Performance Enhancements

item: The Web-based System Manager Remote Client a.k.aWebSM PC CLIENT may need to be
reinstalled

For complete details refer to:
Hardware M anagement Console for pSeries Installation and Operations Guide (SA38-0590-07) -

Chapter 9. Installing and Using the Remote Client



http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/ptf_v3r36mc.html
file:///Z|/projects/s/support_tools/set2/htdocs/data/hps/related/P4%20PDFs%201%20to%2020/HPSservicePack13.0.html#6._The_Web-based_System_Manager_Remote
file:///Z|/projects/s/support_tools/set2/htdocs/data/hps/related/P4%20PDFs%201%20to%2020/HPSservicePack13.0.html#6._The_Web-based_System_Manager_Remote
http://publib16.boulder.ibm.com/pseries/en_US/infocenter/base/hardware_docs/pdf/380590.pdf

1i

HMC Level Check:
Command Line:

Ishmc -V shows:

Version: 3

Release: 3.6

HMC Build level 20050706.1

GUI:

Menu "Help" > "About Hardware Management Console" shows:
Version: 3

Release: 3.6

HMC Build level 20050706.1

Remote Client:(AKA Web-based System Manager AKA WebSM)
Menu "Help" > "About Web-based System Manager” shows:
Build: Wed Jul 6 12:19:47 CST 2005

Level: development

[]

HM C Important Notes.

- Install the HM C code by following the instructions in the HPS Guide.

- Have your IBM CE download the most recent copy of the HPS guide from IBM CORE to get
updated HPS install information.

- Also you should review the HM C information on the web page where you downloaded the
Images.

- This Service Pack REQUIRES:

HMC V3.3.0 (required since Service Pack 6 release) and

HMC V3.3.5 PTF Update.

- HMC V3.3.0isaNEW BASE release of the HMC introduced in Service Pack 6 that uses a new
imbedded kernel.

- Thisversion MAY OVERWRITE root directories (for /, /nome/root and /home/hscroot) deleting
any scripts that may be there.

- Thisversion MAY delete the Power Subsystem Microcode RPM images on your HMC and you
will have to reaquire it for future installs.

- The HMC isnow installed using 2 CD's - Recovery CD filenames. (HMC 3.3.5)

CD 1 of 2RG_BASE 050121.1.is0

CD 2 of 2HMC_REC 334J.2.is0

- Thelogin available at virtual console O (viathe CTRL-ALT-F1 key sequence) is no longer
available.
- New Installation and PTF update installation are supported for this release.




- Upgrade installation is only supported when upgrading from HMC 3.2.X or greater.

As part of any system change - it is recommended to have a hard copy of network connections, 8
port/ran box

configurations and Switch Group IP's.

- Network connections are on the GUI: HMC Maintenance Panel => System Configuration =>
Customize Network

Settings:

|P Address and Netmask for EthernetO and Ethernetl, Default Gateway, Nameserver, Domain

- 8 port RAN box configurations are on the GUI: HMC Maintenance Panel => System
Configuration => Configure

Serial Adapter:

Option 2 shows the current configuration

- Switch Group |P's are on the GUI: Switch Management => Switch Utilities => Switch Group
Configuration

Known problems and issues with the HMC V3 R3.0 Environment:

. wu-ftp will be removed from the HMC distribution. One will be able to ftp out of the HMC
but not into the HMC. The 'scp’' command is available if you enable secure shell (ssh).

. Thewebsm PC client has a performance decline when downloading the plugin classes from
the server. Thefirst time an operation is performed using the client, the task may be slow to
launch. Subsequent use of the task, will respond as normal.

Retain Tip on how to use pesh:

To give IBM support personnel the ability to retrieve certain trace/debug information on the HMC,
the customer should create a user "hscpe" and assign a password. IBM support can contact the
customer to get the password, and then remotely connect to the HMC (with customer consent).

Thisalows IBM support to perform additional functions, such as viewing logs or starting trace to
diagnose problems on the HMC. This user has access similar to the "hscroot" user on HMC. When
accessing the HM C remotely via ssh, the "hscpe” user is put into the restricted shell environment.
To bypass the restricted shell, pesh command is provided. pesh command can only be run by the
"hscpe" user, alowing this user to passin the serial number of the HMC. If the serial number is
correct, the user is required to enter a password obtained from IBM Support. If the password is
correct, then the user is then put into the un-restricted shell as user "hscpe".

Example:

pesh 23A 345K ( enter the serial number in upper case letters)

Y ou will be prompted for a password. Enter password that was provided by IBM Support in lower
case

letters.




The HMC serial number can be queried using the command, "Ishmc -v | grep SE" or read from the
label that is on the front of the HMC.

Use the command "date" to verify that the date of the HMC isfor the day you intend to use the
pesh command.

Starting with HMC Version 3 Release 3.0 and Version 4 Release 1.0, user can also access the
restricted shell terminal on the local HMC, by right mouse click on the desktop and selecting the
Terminal--rshterm task. If one login at the HMC as user hscpe, the pesh command can also be run
from the restricted shell terminal.

For HMC Version 3 Release 3.0 and below, the "hscpe” user id can be created with any role,
however, in order to use some of the High Performance Switch (HPS) debug commands, the
Service Rep role needs to be selected.

For new HMC installation(s) follow the instructions as described in IBM Hardware Management
Console for pSeries Installation and Operations Guide.

To understand how to connect the rs422/rs232 cables see the HPS Guide:

Chapter 6; Step 6, "Install the Hardware Management Console (HMC)” thru

Step 16. "Verify Installation is Complete"”

For “Code load requirements for existing server frames” see Chapter 6

For p655 "Code load requirements for existing p655 server frames'

For p690 "Code load requirements for existing p690 server frames'

SNM/ENM I nstallation Guidelines

Install SNM Software (APAR 1Y67734 , PTF U802490)

For athorough Discussion of the SNM GUI Control panel , please see:
Appendix E. Switch Network Manager (SNM) in pSeries High Performance Switch Planning,

Installation, and Service

Level Check: Version:.1.3.4.0

2a

Disable SNM Software.
The SNM/FNM software should already be disabled from procedure 1.

If not, disable it now.



http://publib.boulder.ibm.com/epubs/pdf/aq1h3mst.pdf
http://publib.boulder.ibm.com/epubs/pdf/aq1h3mst.pdf

2b

Install V3CertisUpdate.zip - required on all of the HM Csin the cluster.

Follow the install instructions at the HMC/SNM Web site:.
http://techsupport.services.ibm.com/ser ver /hmc/power 4/fixessmcode/ptf SNM ServPack 14.

html

NOTE:

Y ou can Install the corrective service directly from the Internet using the HMC Corrective Service
GUI::

Remote Site: techsupport.services.ibm.com

Patch File: /eserver/pseries’hmc/fixes/\VV3CertisUpdate.zip

User ID: For direct internet download, use "anonymous"

Password: For direct internet download, use your email address

The HMC GUI retrieves the update package and begins the install process.
For detailed instructions see the HM C Readme "view" link associated with this Service Pack.

2C

Installation of SNM_Serv_Pack14.zip is required on all of the HMCsin the cluster.

( The version of SNM distributed with HMC 3.3.5 is not the most current version. )

Follow the install instructions by choosing PTF U8034910n the website: http://techsupport.
services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html

Y ou can Install the corrective service file directly from the Internet.

For detailed instructions see theHM C Readme "view" link: Step 3. Install Update ( SubStep 5).

2d

Reboot all HM Csto complete SNM softwar e update.
Note: Do not reboot HMCs until the SNM_Serv_Pack14.zip has been successfully installed on all
HMCs.

2e

After the HMC is rebooted, follow these steps to verify that the corrective service update was
successful:

Select Switch Network Management from the Switch Management folder in the Navigation area.
The Status line, the last line on the Switch Network Management panel, should show:
STATUSRPM Version: 1.3.4.0

Management Properties > Management > 'SNM Version' column will show:
IBMhsc.SNM-1.3.4.0-1

NOTES:

Refer to the pSeries High Performance Switch (HPS) Planning, Installation and Service Guide
(GA22-7951-01) (HPS Guide) for more details on the Switch Network Manager:

Review - Chapter 4. System management components;

Chapter 6. Installation: Bringing the network online: Step 1: Enable SNM

Review - Appendix E. Switch Network Manager (SNM) - The SNM Graphical User Interface



http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/ptf_SNMServPack13.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/ptf_SNMServPack13.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://techsupport.services.ibm.com/server/hmc/power4/fixes/mcode/v3r30.html
http://publib.boulder.ibm.com/epubs/pdf/aq1h3mst.pdf
http://publib.boulder.ibm.com/epubs/pdf/aq1h3mst.pdf

The SNM GUI does NOT update its view automatically. You MUST refresh the display via
the GUI menu "Reload" button - the 5th icon from the | eft.

OR

from the "Menu">"View">"Reload" function

OR

simply pressthe 'F5' key

HPS/SNI LP Installation Guidlines

3 |Install HPS/SNI LP Software.
Level Check: devices.chrp.IBM.HPS.rte devices.chrp.IBM.HPS.rte 1.1.3.1
3a |Application of AIX52 MLO6 provides base level 1.1.3.0.

Apply HPS/SNI LP Base 1.1.3.1 fileset images to LPARs.
(see"AIX LPs" in Section 3: Update/Download Information)
Leave SNM Software disabled.

To verify that the service levelsfor HPS/SNI LP's are current for Service Pack 14, on each logical
partition issue:

IsLP-Lc|egrep "HPS|sni" | cut -d : -f 2,3 [sed 's/:/ /'

or

dsh"IsLP-Lc|egrep \"HPS|sni\" | cut -d : -f 2,3 |sed '¢/:/ /' "'|dshbak|more

Refer to Section 3 - Detailled LP Level Check for correct levels.

If you are upgrading from Service Pack 6 or lower:
do not reboot logical partitions (L PARS). See note 1.
Go to Step 3b

If you are upgrading from Service Pack 7 or higher:
Verify 64 bit kernel is currently in use. Verify the TLP settings. See Note 2.
Reboot LPARS. Y ou should reboot the LPARs as soon as possible to properly integrate the
changes and to avoid disruption of current functionality.
Go to procedure # 4 Install GFW.

Notes:
It is strongly recommended that users read and become familiar with the items covered in this
sections notes: ( HPS/SNI Notes)

1. If you are upgrading from Service Pack 6 or below, do not reboot logical partitions (LPARS)
until after procedure #4 "Install GFW" is complete. Rebooting prematurely will generate
"phantom™ SNI devices! See Problem #1 in the "Known Problems" section of this document for
more information.

2. 1f you are upgrading from Service Pack 7 or higher you should already have set up LPARs to
boot the 64 bit kernel and enabled Technical Large Page (TLP) option.
as described in step 3b.




Verify 64 bit kernel is currently in use (on an LPAR): bootinfo -K
64

Verify the TLP settings:
vmo -ajgrep Ig
lgpg_size = 16777216
lgpg _regions=YYY where YY'Y isthe amount of technical large pages to export
(Ex: lgpg_regions = 256)
soft_min_lgpgs vmpool =0

3b

IBM pSeries HPS now requires that you set up LPARs with 64 bit kernel and enable Technical
Large Page (TLP) option.

After successful installation of HPS Filesets from levels at Service Pack 6 or lower, 64 bit kernel
and technical large page support option must be enabled.

To set up your LPARswith 64 bit kernel:

1) Check which kernel is currently in use: bootinfo -K

aresponse of "32" isa 32bit Kernel

2) In -fs/usr/lib/boot/unix_64 /unix

3) In -fs/usr/lib/boot/unix_64 /usr/lib/boot/unix

4) Determine which rootvg hdisk contains the boot logical volume (usually hds).
This hdisk will be your "ipldevice".

a) Ispv |grep rootvg

hdisk0 009b982332a1f9b8 rootvg active

hdisk1 009b982332a2321a rootvg active

b) Ispv -l hdiskO |grep hd5

hd5 1 1 01..00..00..00..00 N/A

(hdiskO isyour ipldevice)

5) Issue: bosboot -ad /dev/<ipldevice> (eg. bosboot -ad /dev/hdiskO)
6) Reboot: shutdown -Fr

7) Verify 64 bit kernel is running after reboot:

bootinfo -K

64

@eeedeeeeeeceaeaeeeeeeeeeeeeee)

Regarding the use of memory by TLP
Also refer to Regarding the use of memory by RDMA and TLP in Section 2 item # 7 RDMA

transport on HPS

To setup Large Page Option: ( For configuration details, see L arge Page Support in AIX 5L
Version 5.2 Performance Management Guide .)



http://publib.boulder.ibm.com/infocenter/pseries/topic/com.ibm.aix.doc/aixbman/prftungd/prftungd.pdf
http://publib.boulder.ibm.com/infocenter/pseries/topic/com.ibm.aix.doc/aixbman/prftungd/prftungd.pdf

The number of TLP depends on customer configuration and relates to the number of windows
required for each adapter(sni) plus any Large Pages page used by other applications.

Setup L arge Page Option using the vmo command for each node or node group:
vmo -r -0 v_pinshm=1 -0 Igpg_size=16777216 -o Igpg_regions=YY'Y
where YY'Y isthe amount of Technical Large Pages to export.

For Example: To setup a node with 8 sni adapters:
16MB Large Page: Igpg_size = 16777216
256 Large Pages: Igpg_regions = 256
dsh <nodelist> "echo yjvmo -r -o v_pinshm=1 -0 Igpg_size=16777216 -0 Igpg_regions=256"
( Use, echo yjvmo because otherwise vmo will prompt for verification to run bosboot)
Would generate this response:

Setting v_pinshm to 1 in nextboot file

Setting Igpg_size to 16777216 in nextboot file

Setting Igpg_regions to 256 in nextboot file

Warning: some changes will take effect only after a bosboot and a reboot

Run bosboot now?

bosboot: Boot image is 19624 512 byte blocks.

Warning: changes will take effect only at next reboot

NOTE: The vmtune sample program is being phased out and is not supported in future releases. It
Is replaced with the vmo command (for all the pure VMM parameters) and the ioo command (for
al the 1/O related parameters) which can be used to set most of the parameters that were
previously set by vmtune. The -v flag has been added to vmstat to replace the -A flag which
display counter values instead of tuning parameters. For AI1X 5.2, acompatibility script calling
vmo and ioo is provided to help the transition.

To Check that Large Page Option is set:
vmo -ajgrep Ig
lgpg _size = 16777216
lgpg _regions=YYY <where YYY isthe amount of Technical Large Pagesto
export>
soft_min_lgpgs vmpool =0

HPS/SNI Notes

1. Noteson using TLP (L arge Page) Settingsin an HPC environment:

It is strongly recommended that users familiarize themselves with TLP basics and configuration
options available to them, at this location. Federation switch adapter requires TLP usage and these
TLP requirements are documented (see "Hereisaformulato calculate the required TLP" in the




HPS/SNI LPs section below ) in alatter section of this document.
Y ou should also consult the section on Large page feature on AlX in
The AIX 5L Version 5.2 Performance Management Guide

NOTE: Users need to be aware of the usage of the LoadL eveler pre-emption features with TLP
(Large Pages) - specifically the fact that jobs that are using TLP that are pre-empted will
essentially "lock up” the real memory the TLP's use, which is pinned by AIX. Unwise use of TLPs
with LoadLeveler pre-emption can result in exhausting real memory available for jobs. If one
wants LoadL eveler to schedule jobs based on the availability of large page, (especialy if thejobis
going to run in mandatory Large Page mode) he/she may consider making use of the LoadLeveler
consumabl e resource feature. The consumabl e resource function, which has already been around
for several years, is documented in the LoadL eveler manual.

2. Notes on tuning Virtual Memory Settingsin an HPC environment:

Customers should be advised that the AIX VMM parameters (set by the vmo command) minfree
and maxfree will most likely have to be adjusted (increased) in an HPC environment based on
your cluster size, the amount of system memory, and number of processors per CEC. These
settings when tuned properly will ensure enough memory remains available for core cluster
infrastructure applications (RSCT, GPFS, LL). The recommended initial value for these tunables
are minfree = 10000 and maxfree = 12000. Users are strongly urged to consult the following Al X
documentation on virtual memory and vmstat tools and tune their system accordingly.

http://publib16.boulder.ibm.com/doc link/en US/a doc lib/aixbman/prftungd/memperf.htm

http://publib16.boulder.ibm.com/doc link/en US/a doc lib/aixbman/prftungd/memperfl.
htm#i 50853

The AIX 5L Version 5.2 Performance M anagement Guide should also be consulted.

NOTE: Tuning these settings have been shown to help users avoid conditions where core cluster
applications shut down and restart due to extensive blockage caused by "out of memory" issues.
Keep in mind that all cluster applications should be designed and cluster tuned accordingly as to
avoid oversubscribing to the real memory available.

GFW | nstallation Guidelines



http://publib.boulder.ibm.com/infocenter/pseries/topic/com.ibm.aix.doc/aixbman/prftungd/prftungd.pdf
http://publib16.boulder.ibm.com/doc_link/en_US/a_doc_lib/aixbman/prftungd/memperf.htm
http://publib16.boulder.ibm.com/doc_link/en_US/a_doc_lib/aixbman/prftungd/memperf1.htm#i50853
http://publib16.boulder.ibm.com/doc_link/en_US/a_doc_lib/aixbman/prftungd/memperf1.htm#i50853
http://publib.boulder.ibm.com/infocenter/pseries/topic/com.ibm.aix.doc/aixbman/prftungd/prftungd.pdf

Install GFW.

The recommended installation is the AIX command line method - update flash - using locally
available

GFW imgfile.

I mportant Preliminary Notes:

Notes on updating GFW code (system firmware) from the AIX command line

Document Reference: pSeries High Performance Switch Planning, Installation, and Service.

For “Code load requirements for existing p690 and p655 server frames” please see the section in
Chapter 6 titled "Step 3: p690 GFW code load" or "Step 3: p655 GFW code load" respectively in
the HPS guide.

To understand how to connect the rs422/rs232 cables see the HPS Guide:
Chapter 6; Step 6, "Install the Hardware Management Console (HMC)” thru
Step 16. "Verify Installation is Complete"”

For “Code load requirements for existing server frames” see Chapter 6

For p655 " Code load requirements for existing p655 server frames'

For p690 " Code load requirements for existing p690 server frames'

For each CEC on which you want to install the GFW code -

One partition running AlX must have "Service Authority” set. Linux does not support microcode
download at thistime.

The "Service Authority” is set on one LPAR per CEC in the LPAR's profile "other" tab.

This designates the LPAR as authorized to provide update images to the CSP.

All partitions except the one with " Service Authority" must be shut down.

The partition with " Service Authority" must own the device from which the microcode update
image will be read.

It is also recommended that the partition with " Service Authority” have a hard disk.

If the required devices are not in the partition with " Service Authority", the customer or system
administrator must reassign the appropriate resources to it. This requires rebooting the partition
with "Service Authority".

If the firmware on afull system partition is being updated, no special steps are required to perform
the firmware update using the service aid.

Ensure the GFW image file is not corrupted/truncated before you begin the update_flash process.
Check that /var and /tmp directories are not above 50% full on the partition with the service
authority.

The update process can range from 20 minutes to 2 hours, depending on system configuration.
The system reboots itself during the update process. Since SNM is disabled during this process,
the SNI adapter interfaces will NOT be configured, or will be incorrectly configured when the
LPAR(s) reactivate.

It is recommended that you use the "update flash -f* command as opposed to the shutdown -Fu
method.

AIX APAR 1Y 49146 is required for update flash to work correctly. Level Check by running this
command on the partitions:




instfix -ik 1'Y 49146
The "update_flash® command will reboot the CEC(s) and will activate the LPAR(S).
Y ou may find some more detailed instructions provided on the website with the latest image:
Http://techsupport.services.ibm.com/server/mdownl oad2/downl oad.html
http://techsupport.services.ibm.com/server/mdownl oad2/7040681F.html
To install GFW update using Diskette method:
For p690 systems follow the instructions in the HPS guide on "Step 3: p690 GFW (system
firmware code load)" in chapter 6.

To install GFW update using NIM method:
For ap655 CEC viaNIM, follow the HPS guide Chapter 6, "Code load requirements for existing
p655 server frames”, Step 3. GFW (system firmware) code |oad.

Installation steps: (using the recommended AlX command line (update flash) method)

4a

SNM Software should be still disabled. Verify from the SNM GUI Panel.

4b

For each CEC on which you want to install GFW code, shutdown all partitions except the one
with service authority.

4c

Install the appropriate GFW driver on each CEC to be upgraded:
GFW
On the AIX partition with Service Authority:
Copy the GFW firmware update code to /tmp
Enter the following command:
/usr/LP/diagnostics/bin/update flash -gf /tmp/<gfw img file>
The system will apply the new firmware, reboot, and return to the AI1X prompt.
If you use dsh to invoke update flash then use the -g flag so it does not put out a prompt.
Eg. dsh /usr/LP/diagnosticg/bin/update flash -gf /tmp/<GFW img file>
more conveniently: (the'? represents a single character 'wild card' and will select either /
tmp/3H050405.img or /tmp/3J050405.img. Dont have both on the same LPAR.)
dsh [-N <nodegrp>] "echo \"/usr/L P/diagnosticg/bin/update flash -gf tmp/<GFW img file>
\"|at now"
job root.1102366157.aat Mon Dec 6 15:49:17 2004
job root.1102366120.a at Mon Dec 6 15:48:40 2004
job root.1102366242.a at Mon Dec 6 15:50:42 2004

4d

After the LPAR(s) are ‘Running’, Power OFF the CEC(s) from the GUI or using CSM rpower -
not from EPO red switch.



http://techsupport.services.ibm.com/server/mdownload2/download.html

4de

Once the CEC(s) are powered off - follow these steps to enable the SNM/FNM Software from the
GUI:

1. Select Switch Network Management from the Switch Management folder in the Navigation
area.

2a Select Logical Topology on a'per plane' basis.

Select the number of Planes and select the Logical Topology on a per plane basis (Number of
Endpoints on a plane) .

Ex: 2 Frames and 2 Switches with NO Switch-to-Switch Linksis 2 planes; INSB_0ISB_16EP (16
Endpoints)

Ex: 2 Frames and 2 Switches with ANY Switch-to-Switch Linksis 1 plane; 2NSB_0ISB_32EP
(32 Endpoints)

2b Enable SNM Software for Normal Operation
OR
2b Enable SNM Software for Switch Network V erification.

3. After selecting one of the Enable SNM Software tasks, select the Management Properties task.
On the Management tab, the column labeled "SNM Version" should show:
"IBMhsc.SNM.1.3.4.0-1".

NOTES:

The "Enable SNM Software for Switch Network Verification™ task is used during new system
setup/installation or after reconfiguration to initialize and check out the system by NOT removing
bad links or routes. The main purpose is to discover cable mis-wires and defective hardware. No
Routing is modified or loaded. It is NOT intended to be used in aworking environment.

Refer to the HPS Guide for more details on defining the Switch Network Topology:
Review - Chapter 4. System management components; Step 1. Enable SNM
Review - Appendix E. Switch Network Manager (SNM) - The SNM Graphical User Interface

The GUI Does NOT update its view automatically. You MUST refresh the display viathe GUI
menu "Reload" button
\/ ( the 5th icon from the left)

OR

from the "Menu">"View">"Reload" function
OR

simply pressthe 'F5' key

4f

Power up CEC(s) from the HMC GUI and activate logical partition(s).

49

Enable technical large page support - Required for levels greater than Service Pack 6.
Note: Refer to "HPS/SNI" sub-section in the "Installation Guidelines" section for details on

technical large page setup.




4h

Deter mining the level of firmware on the processor subsystem

Firmware level isindicated as. 3xyymmdd.img; where
x = afirmware designation such as Jor H - J = p655, H=p690
yy = year, mm = month, and dd = day of the release.

Check the GFW microcode level from aVTERM to the main SP Menu. This should show the
correct level on thetop line.

Y ou can also check the GFW level from the AIX command line on the active LPAR(S):
#lscfg -vp | grep ater | grep "\.3"

Y ou should see:

ROM Level (aterable)....... < GFW img level>

- or -

ROM Level (aterable)....... < GFW img level>

where < GFW img level> isthe level givenin Section 3 Component info.

4i

Determining the level of HPS adapter microcode

The HPS adapter microcode (ucode) is shipped as part of the GFW update image.

To Level Check the ucode:

From AIX partition, issue: /usr/sni/aix52/debugtools/sni_get ucode version -l sniz

where z = sni interface number on your system anywhere from O thru 7 (Eg. sniO) which can be
seenin

"netstat -in" output. The timestamp should show build date: 09/1/04

NOTE: You will need to reinstall the GFW update if you:

- neglected to disable SNM during the GFW update

- or if you added/replaced an HPS adapter. Otherwise, the HPS ucode may not have been applied
correctly.

Level Check the ucode as stated in the previous bullet to make sure you do not have to reinstall
GFW.

Power Subsystem Microcode | nstallation Guidelines

Install Power Subsystem Microcode on each frame by following these steps:

5a

Download the Power Subsystem Microcode: from :
https://techsupport.services.ibm.com/server/mdownl oad/other.html

to an ftp server.

Install viathe HMC GUI through the Software Maintenance -> Frame panels.

Receive Corrective Service

Install Corrective Service

If you are upgrading from Service Pack 9 or above, the installation of Power Subsystem
Microcode rpm is complete.

Proceed to step 5d to level check installed version.



https://techsupport.services.ibm.com/server/mdownload/other.html

5b

If you are upgrading from Service Pack 8 or lower, the new Power Subsystem Microcode requires
the switches to be recycled for the changes to become effective.

Power cycle switch(s):

From the HMC GUI select “Switch Network Management > Switch Topology View”

For each switch plane

- select " Selected > Power <Off"

- refresh GUI to verify power status

- select " Selected <Power <On"

- refresh GUI to verify power status

Repeat procedure on all switch planes.

5c

Recycle SNM daemon using the HMC GUI:

select Switch Network Management > Disable SNM Software
refresh display: Menu > File > Refresh

>Enable SNM Software.

Notes:
1. Reccommended procedure for a complete power-cycle of the cluster ("EPOW") - ak.a. Cold
Boot Procedure

In the event that power-cycling the HPS switch boards (5b) is not enough
- asalast resort after trying 5b and failing - the following procedure is suggested:

For a compl ete discussion of the subject :

See pSeries High Performance Switch Planning, Installation, and Service; Chapter 9. Service
procedures; Managed system power on and power off (LPAR reboot); p. 170)

The 10 minute wait is for switch framesto stabilize.

Suggested Procedure:
- shutdown all the Ipars
- rpower -acec_off
- stop fnmd
- EPOW off al the CECs and the ISB frame
- start fnmd
- EPOW on the ISB frame and the NSB frames
- wait 10 minutes, EPOW everyone else on
- check for flashing lights on the (optical) risersin the ISBs
- rpower -a cec_on
- tail /var/hsc/log/* Init.log until that stops
- run hps_check.pl
- activate all the Ipars




5d

Level Check

After completing the ptcode installation, go to the HMC GUI and verify successful installation:
- Select: Software Maintenance --> Frame --> Install Corrective Service

- Verify that the "Installed Version" matches the version you just installed

(Important: This window may not automatically refresh when installation compl etes.
Manually refresh the window as necessary. )

5e

Verify HPSis Functioning.

At this point the basic HPS installation is complete. Y ou should now be able to ping over the
switch.

A general check isagood ping all script. The HPS Documentation covers this topic in the host
based verification tool.

- Post Installation Task 2. ( pSeries High Performance Switch Planning, Installation, and Service;
"Run the host-based verification tools’, p116)

If SNM Software is not running then :

The "Switch Management™ | Switch Network Management | views : Switch Topology View, and
End Point View will not be populated and there is a dialog message indicating that and you will
not be able to ping over the switch.

hps_check.pl is not available in a closed box without the root password.

It should show the links as Timed and MPA Available:

L par Name Lpar# Sni# => Adapter# Csp# Cronust => Frame Cage Chip Port : Timed? MPA TOD
c661f1rp021 00251152 YESYESSLV

c661f1rp02111344452YESYESBAK

Al X Installation Guidéelines

Install AIX base updates on each node by following these steps.

See Section 3: AIX download info for the recommended Al X service level for this Service Pack.

For complete instructions on the installation procedures please see:
Document Reference: AIX 5L Version 5.2 Installation Guide and Reference



http://publib16.boulder.ibm.com/pseries/en_US/aixins/insgdrf/insgdrf.pdf

6a

Download and install the recommended Al X 5L version 5.2 service level for this Service Pack

To download:

Go to http://www-1.ibm.com/servers/eserver/support/pseries/aixfixes.html

In the " Search By" drop down box Select "APAR or abstract”

In the "Search String" text box enter the specific fix as given in Section 3: AIX download info
Click in"GO"

This should return atext box with the specific fix requested.

Select that package and click on "Add to my download list"

Y ou can view by clicking on "view my download list"

Repeat these steps for any additional fixes or PTFs
When all the indicated fixes are in the download list click on "continue"

Specify your "Current level" ( oslevel -r will give you the current level of AlIX)
After "Select adownload server"
click on "Continue" and follow instructions for downloading the selected file sets.

Please read the "Memo to Users' in the Download fixes page for installation info and fix info.

6b

Level check AIX by running this command on the logical partition(s):
IsLP -ha bos.mp64

Verify that filesets are at or above the given in Section 3: AIX download info for the
recommended Al X service level for this Service Pack.

Al X LP Installation Guidelines

Install AIX LP updates on each node by following these steps.
Level Check: see"Detailed LP Level Check"

Notes: CSM LP's need to download and install openCIMOM-0.8-1 RPM update.

Document Reference: AIX 5L Version 5.2 Installation Guide and Reference (SC23-4389-03)
IBM RSCT: Administration Guide

Asnoted in the Installation Guide, in order to use CSM LP's, you need to download and install
openCIMOM-0.8-1 RPM update.

Y ou can download openCIMOM from the following web site:
http://www-1.ibm.com/servers/aix/products/aixos/linux/downl oad.html

Select "Package" OpenCIMOM "Version" 0.8 (5.2) (For AIX 5.2)

For complete details see: Chapter 4. Installing the management server; Step 6. Download Open
Source Software of CSM Guide.

Document Reference:

IBM Cluster Systems Management for AI1X 5L Planning and Installation Guide

AIX 5L Version 5.2 Installation Guide and Reference



http://www-1.ibm.com/servers/eserver/support/pseries/aixfixes.html
file:///Z|/projects/s/support_tools/set2/htdocs/data/hps/related/P4%20PDFs%201%20to%2020/HPSservicePack14.5.html#AIX_section_3_download_info
file:///Z|/projects/s/support_tools/set2/htdocs/data/hps/related/P4%20PDFs%201%20to%2020/HPSservicePack14.5.html#AIX_section_3_download_info
http://www-1.ibm.com/servers/aix/products/aixos/linux/download.html

IBM Reliable Scalable Cluster Technology Administration Guide

DPCL isno longer apart of the IBM PE for AIX licensed program.

Instead, DPCL is now available as an open source offering that supports PE.

For more information and to download the DPCL open source project go to:
http://0ss.software.ibm.com/devel operworks/opensource/dpcl

Document Reference: IBM Parallel Environment for AIX 5L Installation Version 4 Release 1.1

I\
Chapter 1. Introducing PE 4.1.1

7a |Download and install the applicable IBM Virtual Shared Disk(VSD) , LAPI, HPS, PPE,
LoadLeveler, GPFS, Parallel ESSL, ESSL, CSM and RSCT PTF updates.

Apply the listed APARs which are needed for HPS Service Pack 14. They are available from the
website:

http://www-1.ibm.com/servers/eserver/support/pseries/ai xfixes.html

If you are upgrading to SP14 from a service pack that is earlier than SP9, then installing CSM 1.4
ISrequired.

The Maintenance package contains CSM 1.4 which requires RPM update openCIMOM 0.8(5.2).

7b | To verify that the service levels for your LP's are current for Service Pack 14, on each logical
partition issue:
IsSLP-Lc | egrep "vsd|LAPI|HPS|sni |ppelL oadL [mmfs|rsctjcsm|essl |pesdl™ | cut -d : -f 2,3 |sed 'S/:/ /'

7c |RSCT Migration Issues. See below Problem 2: "hagsglsm is not reporting the local switch
membership group”

For more information, refer to RSCT Administration Guide; Chapter 3. Creating and
Administering an RSCT Peer Domain; Migration

1. "Phantom" SNI devices may appear after upgrade from pre-Service Pack 7

Users Affected: Users upgrading systems from SP6 or earlier with existing SNI devices



http://oss.software.ibm.com/developerworks/opensource/dpcl
http://publib.boulder.ibm.com/clresctr/windows/public/pebooks.html
http://www-1.ibm.com/servers/eserver/support/pseries/aixfixes.html

Problem Description:

Changes in the HPS switch microcode and driver demand that it is absolutely necessary to install the HPS
fileset updates and the GFW firmware updates without rebooting logical partitions before the system
firmware is successfully installed. Rebooting the LPAR(S) prematurely will cause "phantom” SNI devices
to be created on the partition(s).

Thefailure signatureis:

1) There are twice the number of snX and sniX devices as expected in the "lsdev -C|grep sn" outpui.
(where X = sni or sn interface number on your

system anywhere from 0 thru 7 -- e.g. sniO or sn0)

2) All the sn interfaces are in the Defined state.

3) Upper half of the sniX devicesarein "Available" state (higher numbered devices) and lower half of the
sniX devicesarein "Defined" state (lower

numbered devices).

4)All the sniX devices could also be in the "Defined" state.

Common causes of " phantom" sniX devices:

If you re-boot LPARSs after upgrading HPS filesets, but prior to a successful GFW upgrade.

Failure during GFW upgrade after updating HPS filesets. These events/scenarios will cause all LPARs on
a CEC to reboot without upgrading the GFW via AlX command line method (i.e. update flash command)
- If you have a corrupted/truncated GFW imagefile.

- If either /var or /tmp istoo full.

- If an LPAR other than the Set Service Authority LPAR isin"Running" state during update flash

- If an LPAR other than the Set Service Authority LPAR is used to run the update flash command

Note: There may be other factors that cause LPARSs to reboot after the HPS fileset is upgraded and before
the GFW is successfully updated.

Recovery Procedure:
1) Complete the GFW update.
- Verify that the firmware updates on al CEC(s) was successful.

2) Recover the sniX and snX devices. (Note: To recover requires at least 1 reboot. Two reboots are
required if the sniX devices are busy)

2a) Make note of any customization to the SNI devices (e.g. num_windows, driver_debug, etc ...) using
the command "Isattr -El sniX" so that they can be

re-applied after the recovery procedure. The procedure will reset al values back to the defaults.
Remove all the SNI devices:

for each logical sniX; #eg.for Xin0123;

do

rmdev -d -I sni$X

done

If the rmdev fails for any devices (e.g. deviceis busy), then unconfigure the device driver asfollows.
Otherwise, go to step 2b.
- rename the configuration method for the device: mv /usr/sni/aix52/cfgsni /usr/sni/aix52/cfgsni.orig




- reboot each LPAR that failed

- run the rmdev loop again
- restore the original configuration methods name: mv /usr/sni/aix52/cfgsni.orig /usr/sni/aix52/cfgsni

2b) Remove ONLY thetop half of the snX devices:
The lower half (original half ) have the ipaddr and netmask attributes in the odm. Y ou don't want to delete

these, nor do you have to.

for UPPER HALF of logical snX #e.g.for Xin23;
do

rmdev -d -l sn$X

done

3) Reboot the LPAR(S) --> shutdown -Fr

4) Restore any customization to the SNI devices (e.g. num_windows, driver_debug, etc ...)

2. hagsglsm isnot reporting the local switch member ship group

Component: rsct

Systems Affected: All rsct Users at Service Pack 9

Description:

In order to complete the migration of a peer domain and update the active RSCT version to anew level,
you must enter the runact command:

runact -c IBM.PeerDomain CompleteMigration Options=0"

This command should be run after every RSCT release upgrade.

For a more complete discussion see: "Avoiding Domain Partitioning When Migrating From RSCT 2.2.1.x

or 2.3.0.x"in
IBM Reliable Scalable Cluster Technology Administration Guide SA22-7889-04; Chapter 3. Creating and

Administering an RSCT Peer Domain; Migration

Restrictions:




1. No switch should be power ed off whilethe SNM softwareisrunning.

Component: SNM - Switch Network Management

Systems Affected: High Performance Switch (HPS) users applying from pre-Service Pack 7
I mplications:

- A CEC frame with aswitchin it CANNOT be EPOWed.

- If aCEC has to be power cycled, power down the CEC and not the frame.

- If a CEC frame with a switch needs to be EPOWed, power down the frame, kill the SNM daemon after 5
minutes, power up the frame and restart the SNM daemon.

- If one or more switches need to be recycled, power down the switches, power them back

up and then recycle the SNM daemon after 5 minutes.

2. Rulesfor swapping cablesfor fault isolation

Component: SNM - Switch Network Management

Systems Affected: All HPS Users applying from pre-Service Pack 7
Description:

Only swap SNI attached cables at the switch ports to which they are attached.

Do not swap switch to switch cables with other switch to switch cables nor with SNI attached cables.

Do not swap cables on the SNI ports.

Do not swap cables between switches.

If adapters are accidentally "miswired" during the process of swapping cables, recable the adaptersto their
original positions.

3. Improved performanceis more sensitiveto bad links

Component: HPS/LAPI

Problem Description: The protocol (MPI or LAPI) will timeout if the job runs on bad links and the link
routes are not fixed. If the link failure turns into adapter failure then the job gets terminated.

Solution: To resolve this issue monitor Service Focal Point for bad links and fix them.
4. HPS Cluster recommended L PAR reboot procedure

Component: HPS/SNI

Systems Affected: All HPS Users applying from pre-Service Pack 7

Description:




To ensure the HPS switch links are properly shutdown and re-enabled, it is recommended that you use the
commands below, to recycle and reboot al LPAR/AIX imagesin your cluster:

"shutdown -F" <-- to shutdown LPAR

"shutdown -Fr" or "dsh -av shutdown -Fr" <-- to reboot L PAR or multiple LPARs simultaneously

Use of the "reboot" command or "rpower” commands will not shutdown the HPS switch links in an
orderly fashion - when more than one frame at atime is cycled concurrently the SNM daemon may hang
and Service Focal Point could end up with artificial errors. If/when these commands must be run
concurrently on multiple LPARS, it is recommended that you use them one frame at atime in your cluster.

When the HMC gui is used to cycle an LPAR, it is recommended that you use the "shutdown" option to
recycle the LPAR, not the "reset" option. The "shutdown™ option will ensure that the HPS switch links are
shutdown and re-enabled cleanly - whereas the "reset" option(s) will essentially use the rpower command
(and not do an orderly shutdown).

NOTE: Use of the rpower or HMC GUI reset options should be reserved as a"last resort” for LPARS that
are not responding to a shutdown command.

5. Striping mode Restrictions
Component: HPS/SNI

Description:
- Striping currently limited to two links per task. Multiple tasks can use all links as long as there are more
tasks than half the links available.

- Performance degradation for single task per link of 3% for unidirectional and 5% for exchange
bandwidth at large messages. However, multiple tasks per link get full link bandwidth.

- In non-striping mode you only get half the links on a p655 system using a 2 plane configuration when
setting MP_EUIDEVICE=sn_single. You must use MP_EUDEVICE= csssor sn_all to get al links.

LAPI Abstract: (APARI1Y71750)

Loadleveler Abstract: (APAR 1Y 70885 )

Parallel Environment Abstract: ( APAR 1 Y70883)

IBM Virtual Shared Disk Abstract: (APAR 1 Y70867)




<>GPFS 2.1 Abstract: (APAR 1Y65390)

GPFS 2.2 Abstract: (APAR 1Y70873)

GPFS 2.3 Abstract: (APAR 1Y 70874 )

SNM: Abstract (APAR 1Y 70668 )

HPS/SNI: Abstract (APAR 1Y70869 )

GFW: Abstract
Refer to the following links for complete list of abstracts for GFW fixesin HPS Service Pack 7 or higher:
http://techsupport.services.ibm.com/server/mdownl oad/7040681F.html - for RegattaH

http://techsupport.services.ibm.com/server/mdownload/7039651F.html - for Regatta IH

HMC: SP14 Abstracts:

This package addresses the following issues:

USB keyboard problem on 7315-CR3/ 7310-CR3
Re-Enablesignalsin restricted shell

Support diskette-lessHM Csvia USB for VPD collection
Checkin of SP12 FNM RPMs (hmcpok_rel3)

Java exception when moving slot to another partition.
Activation of [par with | SA busfails.

Flash Memory support

vterm doesn't handlethe Tab key properly in Linux partition
Problemsin sending PMR if Secondary Phone panel isremoved
Updatesto I/O microcode download

New HM C hardwar e support 7315C04/7315CR3.

Provide HM C'sless key file that will prevent shell escape.

Need to clean up session after DL PAR operation.

Critical Data Backup fixes.

Onceenrolled with service agent, LPARsfailsto update their info.
Browser settings not saved after install corrective service.
Removerestriction to use characters” ' /\ $>in password



http://techsupport.services.ibm.com/server/mdownload/7040681F.html
http://techsupport.services.ibm.com/server/mdownload/7039651F.html
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